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Preface

Profile

Before You Begin This Course

Before you begin this course, you should have the following qualifications:

• Working experience with Oracle Inventory

Prerequisites

• Setting up enterprise structures

• Setting up items

• Setting up inventory controls

• Setting up and performing inventory transactions

How This Course Is Organized

Oracle Inventory Replenishment II, Release 11i is an instructor-led course
featuring lecture and hands-on exercises.  Online demonstrations and written
practice sessions reinforce the concepts and skills introduced.
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Related Publications

Oracle Publications

Title Part Number

Oracle Inventory User’s Guide, R11I A83505-01

MRP and Supply Chain Planning User’s Guide A82939-01

Additional Publications

• System release bulletins

• Installation and user’s guides

• read.me files

• Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab
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(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.
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3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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Oracle Inventory Replenishment IIOracle Inventory Replenishment II

Release 11iRelease 11i
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ObjectivesObjectives

After completing this module, you should be able to
do the following:
• Perform Reorder-point planning
• Perform Min-max planning
• Perform replenishment counting
• Generate kanban cards
• Set up available to promise (ATP)
• Perform ATP checks
• Set up inventory planning profile options

After completing this module, you should be able to
do the following:
• Perform Reorder-point planning
• Perform Min-max planning
• Perform replenishment counting
• Generate kanban cards
• Set up available to promise (ATP)
• Perform ATP checks
• Set up inventory planning profile options
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• Module Overview
• Performing Reorder-point planning
• Performing Min-max planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move-orders
• Setting up available to promise (ATP)
• Setting up Inventory profile values

• Module Overview
• Performing Reorder-point planning
• Performing Min-max planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move-orders
• Setting up available to promise (ATP)
• Setting up Inventory profile values
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Course OverviewCourse Overview

Replenishment MethodsReplenishment Methods

Min-max

Reorder-point

Replenishment
counting

Kanban
replenishment

Available SupplyAvailable Supply

Available to
Promise

Planning setupPlanning setup

Planning profile
options
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• Module Overview
• Performing Reorder-point Planning
• Performing Min-max Planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move-orders
• Setting up available to promise (ATP)
• Setting up Inventory profile values
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Uses of Reorder-Point PlanningUses of Reorder-Point Planning

• You can perform-reorder point planning for the
entire organization.

• You can use Reorder-point planning for items
under independent demand.

• You can specify Reorder-point planning as the
inventory planning method when you define an
item.

• You can use Reorder-point planning for items that
you do not need to control very tightly and that are
not very expensive to carry in inventory.

• You can perform-reorder point planning for the
entire organization.

• You can use Reorder-point planning for items
under independent demand.

• You can specify Reorder-point planning as the
inventory planning method when you define an
item.

• You can use Reorder-point planning for items that
you do not need to control very tightly and that are
not very expensive to carry in inventory.
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Reorder-Point Planning: Safety StockReorder-Point Planning: Safety Stock

QuantityQuantityQuantity

Reorder
Point
ReorderReorder
PointPoint

Safety
Stock
SafetySafety
StockStock

TimeTimeTime

Describing Reorder-Point Planning
Recall from Replenishment I that with Reorder-point planning, you order a
quantity when the quantity falls to a predetermined reorder point, as shown in
the above graphic.
Reorder-point planning uses the following pieces of information:

• Safety stock
• Replenishment lead time
• Item demand
• Order cost
• Carrying cost

Safety Stock
Safety stock is the quantity of an item that you plan to have in inventory to
protect against fluctuations in supply and demand. You can manually enter
safety stock quantities, or Oracle Inventory can calculate a safety stock level
based on an existing forecast for an item.
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Reorder-Point Planning: Lead TimeReorder-Point Planning: Lead Time

QuantityQuantityQuantity

Reorder
Point
ReorderReorder
PointPoint

Safety
Stock
SafetySafety
StockStock Lead timeLead timeLead time

TimeTimeTime

Describing Reorder-Point Planning (continued)
Replenishment Lead Time
Replenishment lead time is the total time between recognizing the need to
reorder and the receipt of items. Order processing lead times include the
following components:

• Preprocessing lead time
• Processing lead time
• Postproccessing lead time

Oracle Inventory calculates reorder point planning lead time by adding all three
components.
Item Demand
The reorder point planning routine uses the average demand during the
replenishment lead time. Oracle Inventory uses forecast information to calculate
average demand.
Timing of Reorders
You should reorder when the following is true:
(quantity on hand + quantity on order) < reorder point
where the reorder point = safety stock + [(lead time) × (average demand during
lead time)]
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QuantityQuantityQuantity

Reorder
Point
ReorderReorder
PointPoint
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TimeTimeTime
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Describing Reorder-Point Planning (continued)
Quantity of Reorders
The reorder quantity  is equal to the Economic Order quantity (EOQ). The EOQ
is the quantity that minimizes the total cost of ordering and storing inventory.
Use the following formula to determine the EOQ:
EOQ = SQRT {[2 × (annual demand) × (order cost)] / (annual carrying costs)}
Oracle Inventory calculates the EOQ by using annual demand from the forecast
that you provide when you perform Reorder-point planning. The system also
uses the order and annual carrying costs that you specify when you define items.
You can constrain the reorder quantity by specifying the following information
for each item:

• Fixed-lot multiplier
• Minimum order quantity
• Maximum order quantity

Quantity  on Order
Quantity on order represents supply that you have not yet received. The quantity
on order is the sum of the purchase order, requisition (internal and supplier), and
in-transit quantities owned by the organization.
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Reorder-Point Planning StepsReorder-Point Planning Steps

Enter item planning
attributes.

Forecast item demand.

Define safety stocks.

Run Reorder-point
report.

1

2

3

4
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Entering Item Planning AttributesEntering Item Planning Attributes

Entering item planning attributes includes setting up
general planning attributes. At this point, you also
enter the following:
• Lead times
• Safety stock

Entering item planning attributes includes setting up
general planning attributes. At this point, you also
enter the following:
• Lead times
• Safety stock
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Entering General Planning Attributes for
Reorder-Point Planning

Entering General Planning Attributes for
Reorder-Point Planning

Specify a maximum-
order quantity.

Enter a carrying cost
percent.

Select Reorder-point
as the  inventory
planning method.

Enter an order cost. Specify a fixed-lot
size multiplier.

Specify a minimum-
order quantity.

Organization Items: General Planning Window
(N) Items > Organization Items > (T) General Planning
Carrying Cost Percent
Oracle Inventory uses the carrying cost percent information to calculate the
EOQ for the item.  The annual carrying cost represents you internal cost to stock
one of that item per year.
Carrying cost = (carrying cost percent) × (standard unit cost)
Order Cost
Oracle Inventory uses the order cost to calculate the EOQ for the item.  The
order cost represents the fixed cost of placing an order for any quantity of the
item.
Fixed-lot Size
Oracle Inventory orders a quantity that is a multiple of the fixed-lot size
multiplier.
Minimum-Order Quantity
Oracle Inventory orders a quantity that is at least as large as the minimum-order
quantity.
Maximum-Order Quantity
Oracle Inventory orders a quantity that is less than or equal to the maximum-
order quantity.
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Entering Lead TimesEntering Lead Times

Enter processing lead
time.

Enter preprocessing
lead time.

Enter postprocessing
lead time.

Organization Items: Lead Times Window
(N) Items > Organization Items > (T) Lead Times
Describing Lead Times
You can specify the following lead times:

• Preprocessing lead time: Represents the number of days required to place
a purchase or manufacturing order.

• Processing lead time: Represents the number of days required to procure
or manufacture the item.

• Postprocessing lead time: Represents the number of days required to
deliver a purchased item from the initial supplier receipt of the purchase
order (PO).
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Entering Safety StocksEntering Safety Stocks

You can select one of the following three safety
stock calculation methods for each item:
• User-defined quantity
• User-defined percentage
• Mean absolute deviation

You can select one of the following three safety
stock calculation methods for each item:
• User-defined quantity
• User-defined percentage
• Mean absolute deviation

Accessing the Enter Item Safety Stocks Window
With safety stock, you can enter a user-defined quantity or have the system
calculate a safety stock for you. You enter user-defined quantities in the Enter
Item Safety Stocks window.
(N) Planning > Safety Stocks
If you want Oracle Inventory to calculate safety stock, using the Mean Absolute
Deviation method, you must submit a concurrent request through the Reload
Safety Stock window
(N) Planning > Safety Stock Update
Describing Stock Calculation Methods

• User-defined quantity method:  You can enter safety stock quantities and
the date for which each quantity is effective.  You can update safety stock
quantities that you previously entered or that Oracle Inventory calculated
for you.

• User-defined percentage method: To use the user-defined percentage
method, you must use the Reload Safety Stock window  and specify the
following information for the item:

– A forecast
– A safety stock percent
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Entering Safety Stocks (continued)Entering Safety Stocks (continued)

You can select one of the following three safety
stock calculation methods for each item:
• User-defined quantity
• User-defined percentage
• Mean absolute deviation

You can select one of the following three safety
stock calculation methods for each item:
• User-defined quantity
• User-defined percentage
• Mean absolute deviation

Accessing the Enter Item Safety Stocks Window (continued)
Describing Stock Calculation Methods (continued)

Oracle Inventory uses the following equation to calculate safety stock
quantities:

Safety stock = (safety stock percent) × (forecast demand)
• Mean Absolute Deviation Method: To calculate safety stock using this

method, you submit a concurrent request using the Reload Safety Stock
window.  In this window, you must specify the following information:

– A forecast
– A service level percent

The service level percent represents the probability that you can fill an
order from available inventory.  If you enter a high service level, then
Oracle Inventory calculates relatively larger safety stock quantities.
Oracle Inventory calculates safety stock quantity by using the following
equation:
safety stock = Z × 1.25 × (mean absolute deviation)
where Z is the appropriate value from a table of standard normal
distribution, corresponding to the service level. The mean absolute
deviation is a measure of how the forecast demand deviates from the actual
demand.
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Performing Reorder-Point PlanningPerforming Reorder-Point Planning

In addition to setting up planning attributes, lead
times, and safety stock, Reorder-point planning
involves the following tasks:
• Providing a forecast
• Providing on-order quantity information
• Viewing planning information
• Creating requisitions
• Performing exception reporting

In addition to setting up planning attributes, lead
times, and safety stock, Reorder-point planning
involves the following tasks:
• Providing a forecast
• Providing on-order quantity information
• Viewing planning information
• Creating requisitions
• Performing exception reporting

Providing a Forecast
The reorder-point planning program uses information from the forecast to
calculate the economic order quantity (EOQ) and the reorder-point quantity.
The following equations show each of these calculations:

• EOQ = SQRT {[2 × (annual demand) × (order cost)] / (carrying cost)]}
• Reorder point = safety stock + [(lead time) × (average demand)]

Providing On-Order Quantity Information
Oracle uses on-order quantity information to determine when to reorder an item.
You should reorder when the following is true:
(quantity on hand + quantity on-order) < reorder point
Oracle uses the following sources to calculate on-order quantities:

• Purchase orders
• Requisitions (internal and supplier)
• In-transit shipments owned by the organization

Oracle Inventory uses purchase orders, requisitions, and in-transit shipments
that are scheduled to be delivered before the supply cutoff date.
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Performing Reorder-Point Planning
(continued)

Performing Reorder-Point Planning
(continued)

In addition to setting up planning attributes, lead
times, and safety stock, Reorder-point planning
involves the following tasks:
• Providing a forecast
• Providing on-order quantity information
• Viewing planning information
• Creating requisitions
• Performing exception reporting

In addition to setting up planning attributes, lead
times, and safety stock, Reorder-point planning
involves the following tasks:
• Providing a forecast
• Providing on-order quantity information
• Viewing planning information
• Creating requisitions
• Performing exception reporting

Viewing Planning Information
You can view planning information before creating replenishment orders. If you
want to create replenishment orders automatically, then you must request
requisitions.
Creating Requisitions
Oracle creates requisitions for all items that meet the following condition:
(quantity on hand + quantity on order) < reorder point
Oracle creates either purchase requisitions (if the source is the supplier) or
internal requisitions (if the source is the organization). The reorder quantity is
the EOQ constrained by the following attributes:

• Fixed-lot size multiplier
• Minimum order quantity
• Maximum order quantity

Describing Exception Reporting
You can submit the planning process for all items under reorder-point planning,
or submit  the planning process for just those items that are below their reorder-
point quantities.
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Submitting Reorder-Point Planning
Requests

Submitting Reorder-Point Planning
Requests

To perform reorder-point planning, you submit a
concurrent request through the Reorder Point
Planning concurrent request window. You must
specify the following parameters:
• Item Select
• Demand cutoff date
• Supply cutoff date
• Whether or not to restock
• Default deliver to location
• Forecast

To perform reorder-point planning, you submit a
concurrent request through the Reorder Point
Planning concurrent request window. You must
specify the following parameters:
• Item Select
• Demand cutoff date
• Supply cutoff date
• Whether or not to restock
• Default deliver to location
• Forecast

Reorder Point Planning
(N) Planning > Reorder Point Planning

Describing Reorder-Point Planning Considerations
When submitting Reorder-point planning requests, consider the following:

• Nettable Subinventories: Oracle Inventory uses on-hand quantities that
exist in nettable subinventories only.

• Oracle Inventory displays the sum of all unfulfilled demand created before
the cutoff date.

• Oracle Inventory calculates demand quantity by using information from
the following sources:

– Sales orders
– Internal orders
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Practice 1 Overview: Performing Reorder
Point Planning

Practice 1 Overview: Performing Reorder
Point Planning

Purpose: In this practice, you will set up the
attributes for an item that will enable the system to
perform Reorder-point planning for that item.  You
will also run and view the Reorder-point planning
report.

Purpose: In this practice, you will set up the
attributes for an item that will enable the system to
perform Reorder-point planning for that item.  You
will also run and view the Reorder-point planning
report.

Practice 1: Performing Reorder Point Planning
Instructions

Note: Wherever you see XX, substitute your student number.  If you have not
done so, assign your XX-Item01 to Seattle Manufacturing (M1).
1. Set the item attributes for your XX-Item01 for Reorder Point Planning.

(N) Items > Organization Items
• The Find window opens. Enter your item information, and click the Find
•  button.
• General Planning Tab

– Inventory Planning Method Reorder Point Planning
– Minimum Order Quantity 35
– Order Cost 45
– Carrying Cost Percent 12

• Lead Time Tab
– Processing Lead Time 5

• Save your work.  (M) Action > Save
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Practice 1: Performing Reorder Point
Planning

Practice 1: Performing Reorder Point
Planning

Practice 1: Performing Reorder Point Planning
2.  Enter item safety stock for the item [that you used in Step 1].

(N) Planning > Safety Stocks
• Click the New button
• Tab through the default item field and navigate to the Item field. Enter the

following information:
– Item XX-Item01

– Effective date Today’s date (example: 01-JAN-2000)
– Quantity 50

• Save your work.  (M) Action > Save
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Practice 1: Performing Reorder Point
Planning (continued)

Practice 1: Performing Reorder Point
Planning (continued)

Reorder-Point Planning report parametersReorder-Point Planning report parameters

Practice 1: Performing Reorder Point Planning
3.  Request the Reorder Point Planning report.

(N) Planning > Reorder Point Planning
The Parameters window for the Reorder Point Planning report opens.
• Enter the following parameters:

– Parameters Items under reorder point
– Demand cut off date 4 months from now
– Supply cut off date 4 months from now
– Restock No
– Forecast Your forecast
– Accept all other defaults

• Click the OK button to return to the Reorder Point Planning submit
requests window.

• Click the Submit button to submit the Reorder Point Planning report.
• Write down your request number____________________
• Click the No button when prompted to enter another request.
• Save your work.  (M) Action > Save

4.  Select (M) View > Requests to view your report.
• How many of this item should you reorder?________________
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 Agenda Agenda

• Module Overview
• Performing Reorder-point Planning
• Performing Min-max Planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move-orders
• Setting up available to promise (ATP)
• Setting up Inventory profile values

• Module Overview
• Performing Reorder-point Planning
• Performing Min-max Planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move-orders
• Setting up available to promise (ATP)
• Setting up Inventory profile values
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Uses of Min-Max PlanningUses of Min-Max Planning

• You can use Min-max planning for items with
independent demand.

• Because you specify the minimum and maximum
inventory levels, you can use Min-max planning
for those items that you want to tightly control.

• You can perform Min-max planning for the entire
organization.

• You can perform Min-Max planning for a specific
subinventory.

• You can use Min-max planning for items with
independent demand.

• Because you specify the minimum and maximum
inventory levels, you can use Min-max planning
for those items that you want to tightly control.

• You can perform Min-max planning for the entire
organization.

• You can perform Min-Max planning for a specific
subinventory.
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Min-Max PlanningMin-Max Planning

Run Min-max
report

Enter maximum
quantity

Do you want
specific lot

increments?

Determine minimum
and maximum

quantities

Enter minimum
quantity

Enter minimum
order quantity

Enter fixed lot
increments

YesYes

NoNo

Enter maximum
order quantity

Describing Min-Max Planning
Recall that Min-max planning is a method of determining when and how much
to order based on user-defined minimum and maximum inventory levels.
Note:  To perform organization-level Min-max planning for an item, you must
specify organization-level minimum and maximum quantities.

Deciding When to Order with Min-Max Planning
You should order when the following is true:
(on-hand quantity – demand) + (quantity on order) < minimum quantity
Quantity on order is the sum of purchase order quantities, requisition quantities,
and in transit shipments. It also includes WIP jobs as supply at the organization
level. Quantity on order represents supplies that you have not yet received in
your organization.
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Min-Max Planning:  How Much to Order?Min-Max Planning:  How Much to Order?

The following equation represents when you should
order:

Order quantity = (maximum quantity) - [(on-hand
quantity) + (quantity on order) ]

You can constrain the order quantity by specifying
the following order modifiers for an item:

– Fixed lot multiplier
– Minimum order quantity
– Maximum order quantity

The following equation represents when you should
order:

Order quantity = (maximum quantity) - [(on-hand
quantity) + (quantity on order) ]

You can constrain the order quantity by specifying
the following order modifiers for an item:

– Fixed lot multiplier
– Minimum order quantity
– Maximum order quantity
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Min-Max Planning StepsMin-Max Planning Steps

Enter item planning
attributes.

Define subinventory-
level min-max

information (optional).

Run the Min-max
report.

1

2

3
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Item Planning AttributesItem Planning Attributes

Item planning attributes include setting up general
planning attributes for either the organization or the
subinventory in which you want to use Min-max
planning.

Item planning attributes include setting up general
planning attributes for either the organization or the
subinventory in which you want to use Min-max
planning.
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Min-Max Planning Setup ProcedureMin-Max Planning Setup Procedure

Enter the following:
•Min-max minimum quantity
•Min-max maximum quantity
•Fixed-lot-size multiplier
•Minimum order quantity
•Maximum order quantity

Specify a planning level
(either Organization or

Subinventory).

Set up the appropriate
profile value for

requisition approval.

Select an Inventory
Planning method.
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Setting Up the Min-Max System Profile
Value

Setting Up the Min-Max System Profile
Value

INV:INV:    Minmax Reorder Approval - YES or NO Minmax Reorder Approval - YES or NO 

Entering Min-Max Approval Status
When you run the Min-max report, the INV: Minmax Reorder Approval profile
option enables you to create requisitions as either approved or unapproved.
How to Enter a Min-Max Approval Status
To enter a min-max requisition approval status, navigate to the System Profiles
window to enter a personal or system profile value to specify a min-max reorder
approval status.
(N) Setup > Profiles > Personal
A Find window appears. Enter “%Minmax%” in the find window to locate the
Minmax Reorder Approval profile option.
Note:  If you do not have access to system-level profile values, ask your system
administrator for assistance in setting up the system-level Minmax Reorder
Approval profile option.
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Selecting a Planning LevelSelecting a Planning Level

You can select Min-max planning as the inventory
planning method for each item. If you select the Min-
max planning method for an item, Oracle performs
Min-max planning for that item at both the
organization and subinventory levels. To perform
Min-max planning at both the organization and the
subinventory levels, you need to enter minimum and
maximum quantities for each level.

You can select Min-max planning as the inventory
planning method for each item. If you select the Min-
max planning method for an item, Oracle performs
Min-max planning for that item at both the
organization and subinventory levels. To perform
Min-max planning at both the organization and the
subinventory levels, you need to enter minimum and
maximum quantities for each level.
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Entering Planning AttributesEntering Planning Attributes

Specify a maximum
order quantity.

Enter min-max
minimum quantity.

Specify a fixed-lot-size
multiplier.

Specify a minimum
order quantity.

Enter min-max
maximum quantity.

Select an inventory
planning method.

Entering Item Planning Attributes
After you select a planning level, either Organization or Subinventory, you enter
the appropriate planning attributes. The following table describes these
attributes in more detail:

Planning Attribute Organization-Level Subinventory-Level
Min-Max Minimum
Quantity

Compares the item’s on-
hand quantity in the entire
organization to the item’s
organization-level min-
max minimum quantity

Compares the item’s on-hand quantity
in the specific subinventory to the
item’s subinventory level min-max
minimum quantity

Min-Max Maximum
Quantity

Uses the organization-
level  min-max maximum
quantity to calculate the
order quantity

Uses the item’s subinventory-level
min-max maximum quantity to
calculate the order quantity

Fixed-Lot-Size-
Multiplier

Calculates order quantities
that are multiples of the
fixed-lot-size multiplier

Calculates order quantities that are
multiples of the fixed-lot-size
multiplier

Minimum Order
Quantity

Calculates order quantities
that are greater than or
equal to the minimum
order quantity

Calculates order quantities that are
greater than or equal to the minimum
order quantity

Maximum Order
Quantity

Calculates order quantities
that are less than or equal
to the maximum order
quantity

Calculates order quantities that are less
than or equal to the maximum order
quantity
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Submitting the Min-Max Planning
Requests

Submitting the Min-Max Planning
Requests

In addition to setting up planning attributes, Min-max
planning involves submitting a concurrent process
that generates the Min-max planning report. You can
also perform exception reporting with the Min-max
planning reporting feature.

In addition to setting up planning attributes, Min-max
planning involves submitting a concurrent process
that generates the Min-max planning report. You can
also perform exception reporting with the Min-max
planning reporting feature.

Submitting the Min-Max Planning Report
When you submit the Min-max planning report, you must specify a number of
parameters, including parameters that address the following:

• Nettable Subinventories
• Demand quantities
• On-order quantity information
• Requisitions and WIP unrealized jobs
• Exception reporting

Using Nettable Subinventories
Oracle Inventory enables you to use on-hand quantities that exist in either
nettable or non-nettable subinventories, or both.
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Submitting the Min-Max Planning
Requests (continued)

Submitting the Min-Max Planning
Requests (continued)

From the Oracle Inventory Navigator, use the
following navigation path to submit a Min-max
planning request :

(N) Reports > Planning

From the Oracle Inventory Navigator, use the
following navigation path to submit a Min-max
planning request :

(N) Reports > Planning

Submitting the Min-Max Planning Report (continued)
Displaying Demand Quantity

Oracle Inventory displays the sum of all unfulfilled demand created before the
cutoff date. The system calculates demand quantity by using information from
the following sources:

• Sales orders
• Internal orders

You can include WIP job component requirements as a source of demand as
well.  You can net unfulfilled demand against on-hand quantity and also include
inventory reservations in netting on-hand quantity against demand.
Viewing Planning Information
You can view planning information before creating replenishment orders. To
automatically create replenishment orders, you must request requisitions.
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Submitting the Min-Max Planning
Requests (continued)

Submitting the Min-Max Planning
Requests (continued)

You can submit the planning process for all items
under min-max planning. You can also submit the
planning process for just those items under their
minimum quantities and submit the planning process
for just those items over the maximum quantities.

You can submit the planning process for all items
under min-max planning. You can also submit the
planning process for just those items under their
minimum quantities and submit the planning process
for just those items over the maximum quantities.

Submitting the Min-Max Planning Report (continued)
Creating Requisitions and WIP Unrealized Jobs

If you request a restock, Oracle Inventory creates requisitions and WIP
unreleased jobs for all items that meet the following condition:
(on-hand quantity) +  (quantity on order) < minimum quantity
Oracle Inventory creates purchase requisitions (if the source is Supplier) and
internal requisitions (if the source is Inventory Organization) for all Buy items,
and WIP unreleased jobs for all Make items. The order quantity is constrained
by the following attributes:

• Fixed-lot size multiplier
• Minimum order quantity
• Maximum order quantity
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Practice 2 Overview: Performing Min-Max
Planning

Practice 2 Overview: Performing Min-Max
Planning

Purpose: In this practice, you will enter attributes for
an item that will enable the system to perform
Min-max planning for that item.  You will also run and
view the Min-max planning report.

Purpose: In this practice, you will enter attributes for
an item that will enable the system to perform
Min-max planning for that item.  You will also run and
view the Min-max planning report.

Practice 2: Performing Min-Max Planning
Instructions

Note: Wherever you see XX, substitute your student number.  If you have not
done so, assign your XX-Item03 to Seattle Manufacturing (M1).
1. Set the item’s general planning attributes for your XX-Item03 for Min-
Max Planning.

(N) Items > Organization Items
The Find window opens. Enter your item, and click the Find button.
• General Planning Attributes tab

– Inventory Planning Method Min-Max Planning
– Min-max Quantity:  Minimum 500
– Min-max Quantity:  Maximum 3000

• Select (M) File > Save
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Practice 2: Performing Min-Max PlanningPractice 2: Performing Min-Max Planning

Practice 2: Performing Min-Max Planning
2.  In this practice, you run your Min-Max report by subinventory, so you need
to enter the min-max quantities for the item/subinventory combination, or
special item/subinventory.  If you have not closed the Organization Items
window, skip the next navigation step to reopen the Organizational Items
window, and select (M) Tools > Items/Sub-inventories.
(N) Items > Organization Items
Enter your item in the Find window and then click the Find button.
(M) Tools > Item Subinventories

• Enter the following information for the item:
– Name Select the FGI subinventory
– Min-Max Planning checkbox Selected
– Minimum Quantity 300
– Maximum Quantity 900

• Save your work. (M) File > Save
Note: These general planning attributes affect organization-level planning, not
subinventory-level planning.
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Practice 2: Performing Min-Max Planning
(continued)

Practice 2: Performing Min-Max Planning
(continued)

Practice 2: Performing Min-Max Planning
3.  Request the Min-Max Planning report for your FGI subinventory.

(N) Reports > Planning
• In the Report Name field, select the Min-Max Planning Report from the

list of values.
• Click the Save icon to save your selection.
• Click the Submit Request button to submit your request.

Write down the concurrent request ID number __________.
• View your report.

(M) View > Requests



Copyright © Oracle Corporation, 2000. All rights reserved.

Oracle Inventory Replenishment II, Release 11i
Chapter 1 - Page 39

Agenda

Copyright  Oracle Corporation, 2000. All rights reserved.
®

 Agenda Agenda

• Module Overview
• Performing Reorder-point Planning
• Performing Min-max Planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move-orders
• Setting up available to promise (ATP)
• Setting up Inventory profile values

• Module Overview
• Performing Reorder-point Planning
• Performing Min-max Planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move-orders
• Setting up available to promise (ATP)
• Setting up Inventory profile values
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Uses of Replenishment CountingUses of Replenishment Counting

Recall that replenishment counting is a method of
ordering items for nontracked subinventories. You
can perform counts for the nontracked
subinventories and then have Oracle Inventory check
these counts against the minimum quantities that you
have specified. Oracle Inventory creates requisitions
that are based on the sourcing options that you
specify for each item.

Recall that replenishment counting is a method of
ordering items for nontracked subinventories. You
can perform counts for the nontracked
subinventories and then have Oracle Inventory check
these counts against the minimum quantities that you
have specified. Oracle Inventory creates requisitions
that are based on the sourcing options that you
specify for each item.
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Subinventory Replenishment Planning
Steps

Subinventory Replenishment Planning
Steps

Specify requisition
approval status. Define subinventory.

Define subinventory
replenishment
information.

Enter replenishment
counts.

1 2

3 4

Create requisitions.Validate and process
replenishment counts.

5 6
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System Profile ValuesSystem Profile Values

You can specify whether requisitions created should
be preapproved. If you select the preapproved
requisition status, requisitions created by the
Replenishment Counting Process do not have to be
approved in Oracle Purchasing. You can specify a
requisition approval status for your Oracle Inventory
installation.

Use the following navigation path to access the
System Profile Values window:

(N) Setup > Profiles > System (B) Find

You can specify whether requisitions created should
be preapproved. If you select the preapproved
requisition status, requisitions created by the
Replenishment Counting Process do not have to be
approved in Oracle Purchasing. You can specify a
requisition approval status for your Oracle Inventory
installation.

Use the following navigation path to access the
System Profile Values window:

(N) Setup > Profiles > System (B) Find
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Subinventory Setup WindowsSubinventory Setup Windows

Use the following windows to set up and process
subinventories for which you want to enter
replenishments counts:
• Subinventories
• Item Subinventories
• Replenishment Count Headers
• Replenishment Count Lines
• Process Replenishment Counts
• Purge Replenishment Counts

Use the following windows to set up and process
subinventories for which you want to enter
replenishments counts:
• Subinventories
• Item Subinventories
• Replenishment Count Headers
• Replenishment Count Lines
• Process Replenishment Counts
• Purge Replenishment Counts
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Subinventories WindowSubinventories Window

(N) Setup > Organizations > Subinventories (B) New >
(B) Open

In this window, you can define subinventories for
which you want to perform replenishment counts.

(N) Setup > Organizations > Subinventories (B) New >
(B) Open

In this window, you can define subinventories for
which you want to perform replenishment counts.
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Item Subinventories WindowItem Subinventories Window

Access the Item Subinventories window to enter
minimum and maximum quantities for each item
that you store in a subinventory.

(N) Setup > Organizations > Subinventories (B)
Item/Subinventory

Access the Item Subinventories window to enter
minimum and maximum quantities for each item
that you store in a subinventory.

(N) Setup > Organizations > Subinventories (B)
Item/Subinventory

Specifying Min-Max Planning
To enter replenishment counts for an item, you must specify subinventory-level
min-max planning for the item.

Entering Subinventory-Level Min-Max Minimum and Maximum
Quantities

You can use the Min-max method to replenish subinventories.  In one
replenishment count entry method, you can order the min-max maximum
quantity.
In another replenishment count entry method designed only for nontracked
subinventories, you can enter an on-hand quantity, after which Oracle Inventory
performs min-max calculations.
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Item Subinventories:  Order Modifier TabItem Subinventories:  Order Modifier Tab

In the Item Subinventories window, Order Modifier
tabbed region, you specify the following information:
• Fixed-lot-size multiplier
• Minimum order quantity
• Maximum order quantity

Use the following navigation path to access the order
modifiers window.

(N) Setup > Organizations > Subinventories > (T)
Order Modifiers

In the Item Subinventories window, Order Modifier
tabbed region, you specify the following information:
• Fixed-lot-size multiplier
• Minimum order quantity
• Maximum order quantity

Use the following navigation path to access the order
modifiers window.

(N) Setup > Organizations > Subinventories > (T)
Order Modifiers

Entering Order Modifiers
Fixed-Lot-Size Multiplier
When you perform replenishment counting, Oracle Inventory calculates order
quantities that are multiples of the fixed-lot-size multiplier.
Minimum Order Quantity
When you perform replenishment counting, Oracle Inventory calculates order
quantities that are greater than the minimum order quantity.
Maximum Order Quantity
When you perform subinventory replenishment, Oracle Inventory calculates
order quantities that are less than the maximum order quantity.



Copyright © Oracle Corporation, 2000. All rights reserved.

Oracle Inventory Replenishment II, Release 11i
Chapter 1 - Page 47

Replenishment Count Headers

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Replenishment Count HeadersReplenishment Count Headers

You can enter counts to replenish subinventories.
Oracle Inventory replenishes subinventories
according to the method that you use to enter counts.
Oracle Inventory does not store on-hand quantity
information for nontracked subinventories.

Use the following navigation path to access the
Replenishment Count Header window:

(N) Counting > Replenishments Counts > Counts (B)
New

You can enter counts to replenish subinventories.
Oracle Inventory replenishes subinventories
according to the method that you use to enter counts.
Oracle Inventory does not store on-hand quantity
information for nontracked subinventories.

Use the following navigation path to access the
Replenishment Count Header window:

(N) Counting > Replenishments Counts > Counts (B)
New

Entering Replenishment Count Header Information
In the Replenishment Count Header window, you enter a name and
subinventory for which you want to perform replenishment counting.
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Replenishment Count LinesReplenishment Count Lines

You can select one of three replenishment count
types for each item:
• On-hand quantity
• Order maximum
• Order quantity

Use the following navigation path to access the
Replenishment Count Lines window:

(N) Counting > Replenishment Counts > Counts (B)
Lines

You can select one of three replenishment count
types for each item:
• On-hand quantity
• Order maximum
• Order quantity

Use the following navigation path to access the
Replenishment Count Lines window:

(N) Counting > Replenishment Counts > Counts (B)
Lines

Entering Replenishment Count Lines
You must enter replenishment count header information to enter replenishment
count lines  for items that are associated with the subinventory that you specify.
On-Hand Quantity
This method is designed only for nontracked subinventories.  The item for
which you select this method must be a min-max planned item.
You can count the contents of the subinventory and then enter the on-hand
quantity.  Oracle Inventory uses the quantity that you enter to perform min-max
comparisons and to generate requisitions.
Requisition quantities are constrained by fixed-lot multiple quantities,
maximum order quantities, and minimum order quantities.  Oracle Inventory
uses the sourcing options defined for that item and subinventory combination.
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You can select one of three replenishment count
types for each item:
• On-hand quantity
• Order maximum
• Order quantity

You can select one of three replenishment count
types for each item:
• On-hand quantity
• Order maximum
• Order quantity

Explaining Replenishment Count Types (continued)
Order Maximum
The item for which you select this method must be a min-max planned item.
Oracle Inventory generates a requisition in the min-max maximum quantity
specific to that  item and subinventory combination.
Requisition quantities are constrained by fixed-lot multiple quantities,
maximum order quantities, and minimum order quantities.  You cannot enter a
quantity if you select this option.
Oracle Inventory uses the sourcing options defined for that item and
subinventory combination.
Order Quantity
The item for which you select this method can be planned using any
replenishment planning method.  With the Order Quantity count type, Oracle
Inventory generates a requisition for the quantity that you enter.  Requisition
quantities are constrained by fixed-lot multiple quantities, maximum order
quantities, and minimum order quantities.  Oracle Inventory uses the sourcing
options defined for that item and subinventory combination.



Copyright © Oracle Corporation, 2000. All rights reserved.

Oracle Inventory Replenishment II, Release 11i
Chapter 1 - Page 50

Processing  Replenishment Counts

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Processing  Replenishment CountsProcessing  Replenishment Counts

The replenishment processor performs the
calculations that are necessary to verify whether
Oracle Inventory should create requisitions. You can
select whether Oracle Inventory should process the
replenishment counts. You can save your changes
and run the replenishment processor later.

Use the following navigation path to access the
Process Replenishment Counts window and submit a
replenishment counts request::

(N) Counting > Replenishment Counts > Process
 Interface

The replenishment processor performs the
calculations that are necessary to verify whether
Oracle Inventory should create requisitions. You can
select whether Oracle Inventory should process the
replenishment counts. You can save your changes
and run the replenishment processor later.

Use the following navigation path to access the
Process Replenishment Counts window and submit a
replenishment counts request::

(N) Counting > Replenishment Counts > Process
 Interface

Entering Counts Using External Devices
You can use external data collection devices, such as bar code readers to enter
replenishment counts. You can run the replenishment validator and processor
after entering counts directly into the replenishment open interface.
Submitting the Replenishment Validator and Processor
The replenishment validator reads the count records that exist in the interface
table.  The interface table stores the counts that you enter with an external
device.  Oracle validates the items, subinventories, and counts, and then writes
the records to the count tables.  The replenishment count processor performs the
calculations that are necessary to determine whether Oracle should create
requisitions. Oracle creates internal or purchase requisitions according to each
item’s default sourcing options. Run the replenishment validator program before
submitting the replenishment processor.
Purging Replenishment Counts
If you want to purge replenishment counts, use the following navigation path to
access the Purge Replenishment Counts window:
(N) Counting > Replenishment Counts > Purge
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You typically use replenishment counting to perform
counts for tracked inventory items.
• True
• False

You typically use replenishment counting to perform
counts for tracked inventory items.
• True
• False
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You typically use replenishment counting to perform
counts for tracked inventory items.
• True
• False

False:  Replenishment counting is a method of
ordering items for nontracked subinventories.

You typically use replenishment counting to perform
counts for tracked inventory items.
• True
• False

False:  Replenishment counting is a method of
ordering items for nontracked subinventories.
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• Module Overview
• Performing Reorder-point Planning
• Performing Min-max Planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move-orders
• Setting up available to promise (ATP)
• Setting up Inventory profile values

• Module Overview
• Performing Reorder-point Planning
• Performing Min-max Planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move-orders
• Setting up available to promise (ATP)
• Setting up Inventory profile values
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Part B

 KANBAN

Part A

 KANBAN

• Shorter lead times

• Reduced inventory

•• Shorter lead times Shorter lead times

•• Reduced inventory Reduced inventory

Describing Kanban Replenishment
Recall that a kanban system is a self-regulating pull system that leads to shorter
lead times and reduced inventory. Kanban systems are typically applied to items
with relatively constant demand and medium-to-high production volume.
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To define a kanban planned item, you must set the
Release Time Fence attribute in the MPS/MRP
Planning attribute group to the Kanban Item (Do Not
Release) option in the Master Items window. Use the
following navigation path to access the MPS/MRP
Planning attribute:
(N) Items > Master Item

Only kanban planned items can be used in defining a
pull sequence.

To define a kanban planned item, you must set the
Release Time Fence attribute in the MPS/MRP
Planning attribute group to the Kanban Item (Do Not
Release) option in the Master Items window. Use the
following navigation path to access the MPS/MRP
Planning attribute:
(N) Items > Master Item

Only kanban planned items can be used in defining a
pull sequence.
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After you set the master item Release Time Fence,
you can define kanban pull sequences. Use the
following navigation path to access the Pull
Sequences Summary window:
(N) Kanban > Pull Sequences > (T) Source

From the Pull Sequence Summary window, you can
view existing kanban cards or generate new ones.

After you set the master item Release Time Fence,
you can define kanban pull sequences. Use the
following navigation path to access the Pull
Sequences Summary window:
(N) Kanban > Pull Sequences > (T) Source

From the Pull Sequence Summary window, you can
view existing kanban cards or generate new ones.

Defining Pull Sequence Sources
For every kanban planned item, you must define a pull sequence, which is a
series of kanban locations that model the replenishment network on the shop
floor. A kanban location can be a subinventory locator.  The replenishment
source for a kanban location can be another kanban location, a production line,
or an external source.  You can use locators even if locator control is turned off
at the organization, and item levels.
Kanbans can be sourced from an external supplier or an internal organization.
A Supplier source type kanban triggers a purchase request to the supplier, while
an Inter-org. source type kanban results in an inter-organization transfer.
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Kanban cards are created for an item, subinventory,
and locator (optional). They are uniquely identified by
a kanban number. For cards generated from a kanban
pull sequence, the number is automatically
generated. For manually defined cards, both
replenishable and nonreplenishable, you can enter an
unused kanban number or let the system create the
number.

Use the following navigation path to access the
kanban generation window:

(N) Kanban > Pull Sequences (T) Kanban

Kanban cards are created for an item, subinventory,
and locator (optional). They are uniquely identified by
a kanban number. For cards generated from a kanban
pull sequence, the number is automatically
generated. For manually defined cards, both
replenishable and nonreplenishable, you can enter an
unused kanban number or let the system create the
number.

Use the following navigation path to access the
kanban generation window:

(N) Kanban > Pull Sequences (T) Kanban

Describing Replenishment Cards
You cannot override the quantity for generated cards, but you can add additional
cards or delete existing cards from the pull sequence to control the inventory in
the replenishment chain.
A supply source defaults from the sourcing rules if a sourcing rule is available
for the item and kanban location.  Only the primary supplier, based on the split
percentage and ranking, is used. You can manually override the quantity and
supply source on a pull sequence only before the cards that have been printed.
Changes to the pull sequence are not reflected until the old cards are deleted and
new ones are created.  Updates to the sourcing rules apply only to cards created
after the update.
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Kanban cards are generated with a default card
status of Active.  When you define a card manually,
you can initially give it either Active or Hold status.
You can terminate use of a card by changing the
card status to Canceled, but you cannot reverse this
change. Only canceled cards can be deleted.

Kanban cards are generated with a default card
status of Active.  When you define a card manually,
you can initially give it either Active or Hold status.
You can terminate use of a card by changing the
card status to Canceled, but you cannot reverse this
change. Only canceled cards can be deleted.
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All of the following supply status codes can be set
manually. With the exception of the In-Transit status,
all statuses can also be set automatically.
• New
• Empty
• Full
• Wait
• In-Process
• In-Transit

All of the following supply status codes can be set
manually. With the exception of the In-Transit status,
all statuses can also be set automatically.
• New
• Empty
• Full
• Wait
• In-Process
• In-Transit

Describing Supply Statuses
The following table describes supply statuses in more detail:
Supply Status Description

New Indicates that the kanban has just been created and is not yet
part of the replenishment chain

Empty Indicates that the kanban is empty and that a replenishment
signal has been generated

Full Indicates that the kanban has been replenished

Wait Indicates that the kanban is waiting until the minimum order
quantity has been met by the aggregation of cards

In-Process For the Supplier source type, indicates that the purchase order
has been approved.  For the Interorganization source type,
indicates that the internal requisition has been approved.

In-Transit Indicates that you have received an advanced shipping notice
(ASN) that the kanban has shipped, but that you have not yet
received it
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With Oracle Inventory, Release 11i, the following
options for kanban replenishment sourcing have
been added to the application:
• Intra-org replenishment
• Production replenishment

With Oracle Inventory, Release 11i, the following
options for kanban replenishment sourcing have
been added to the application:
• Intra-org replenishment
• Production replenishment

Describing Kanban Sources of Replenishment
If you specify a kanban replenishment source of intra-organization, then Oracle
Inventory creates a preapproved move order that is referenced to the
corresponding kanban card.
If you specify a kanban replenishment source of intra-organization, then Oracle
Inventory creates a work order or repetitive schedule.
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You can print kanban cards for a replenishment plan
or a replenishment chain when you generate the
cards.  You can also print cards individually if the
card information is complete. You can print duplicate
cards only if the original is lost or voided.  You are
given a warning message before.

You can print kanban cards for a replenishment plan
or a replenishment chain when you generate the
cards.  You can also print cards individually if the
card information is complete. You can print duplicate
cards only if the original is lost or voided.  You are
given a warning message before.
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Practice 3 Overview: Generating Kanban
Cards

Practice 3 Overview: Generating Kanban
Cards

Purpose: In this practice, you will perform the
 following activities:
• Setup item pull sequences
• Generate kanban cards

Purpose: In this practice, you will perform the
 following activities:
• Setup item pull sequences
• Generate kanban cards

Practice 3: Generating Kanban Cards
Instructions

Note: Wherever you see XX, substitute your student number.
1. Use the Source, Kanban, and Planning tabs to set up a pull sequence for your
item that has been kanban enabled.

(N) Kanban > Pull Sequences
• Organization M1 - Seattle Manufacturing
• Item Select your kanban enabled item
• Subinventory Stores
• Locator 99.110.50 (or provided by the instructor)
• Supplier Advanced Networking Devices
• Supplier Site Santa Clara
• Calculate field Number of cards
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Practice 3: Generating Kanban Cards
1.  (Continued from Step 1 on the previous page).

• Size 10
• Cards 10
• Minimum Quantity 20
• Lead time 3
• Allocation % 75
• Safety Stock 1

When you finish entering the pull sequence information, save your work.
2.  Click the Generate Cards button to generate your kanban cards.
3.  Click the Cards button to view your kanban cards for accuracy.
4.  For the first two cards, click the Open button to view all of the details for the
selected cards.
5.  For the first card, click the Replenish button to generate a replenishment
signal and to verify that the supply status is now Wait.
6.  For the second card, click the Replenish button to generate a replenishment
signal and to verify that the supply status of the card is Empty.
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• Module Overview
• Performing Reorder-point Planning
• Performing Min-max Planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move-orders
• Setting up available to promise (ATP)
• Setting up Inventory profile values
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Overview of Move OrdersOverview of Move Orders

Org. AOrg. A

Location B55Location B55

Org. AOrg. A

Location C84Location C84

Describing Move Orders
Move orders are requests for the movement of material within a single
organization.  Move orders enable planners and facility managers to request the
movement of material within a warehouse or facility for purposes, such as
replenishment, material storage relocations, and quality handling. You can
generate move orders either manually or automatically depending n the source
type that you use.
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To perform move orders, you must select one
of the following move order source types:
• Move order requisitions
• Replenishment move orders
• Pick wave move orders

This module describes replenishment move orders.
For more information about move order requisitions
and pick wave move orders, access the Oracle
Inventory online help topic for move orders.

(Help) Oracle Inventory > Transactions > Overview of
Move Orders

To perform move orders, you must select one
of the following move order source types:
• Move order requisitions
• Replenishment move orders
• Pick wave move orders

This module describes replenishment move orders.
For more information about move order requisitions
and pick wave move orders, access the Oracle
Inventory online help topic for move orders.

(Help) Oracle Inventory > Transactions > Overview of
Move Orders

Setting the Inventory Source Type
For Min-max planning and replenishment counting, you can set the
subinventory source type at the following levels:

• Master/Organization Items
• Subinventory
• Item Subinventory

For kanban pull sequence cards, you set the subinventory source type at the Pull
Sequence level.
After you set up the subinventory source type and other move order attributes,
Oracle Inventory will automatically create a preapproved move order when you
run the corresponding planning report, such as the Min-Max Planning report.
For more information about specifying the inventory source type and setting up
move orders, access the following Oracle Inventory online help:
(Help) Oracle Inventory > Overview of Move Orders > Setting Up Move Orders
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Destination:Destination:
ReplenishmentReplenishment

neededneeded

Move orderMove order
automaticallyautomatically

createdcreated

SourceSource

Describing Replenishment Move Orders
Oracle Inventory enables you to automatically create pre-approved move orders
using any of the following replenishment planning methods:

• Min-Max planning
• Replenishment counting
• Kanban replenishment

When using one of these planning methods, Oracle Inventory generates move
orders if the material is sourced from another inventory location within the
organization.
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Submitting the Min-Max Planning
Requests

In addition to setting up planning attributes, Min-max
planning involves submitting a concurrent process
that generates the Min-max planning report. You can
also perform exception reporting with the Min-max
planning reporting feature.

In addition to setting up planning attributes, Min-max
planning involves submitting a concurrent process
that generates the Min-max planning report. You can
also perform exception reporting with the Min-max
planning reporting feature.

Submitting the Min-Max Planning Report
When you submit the Min-max planning report, you must specify a number of
parameters, including parameters that address the following:

• Nettable subinventories
• Demand quantities
• On-order quantity information
• Requisitions and WIP unrealized jobs
• Exception reporting

Using Nettable Subinventories
Oracle Inventory enables you to use on-hand quantities that exist in either
nettable or non-nettable subinventories, or both.
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You must specify a Pick Wave Move Order source
type if you want Oracle Inventory to automatically
generate move orders when you run a replenishment
planning method, such as Min-Max planning.
• True
• False

You must specify a Pick Wave Move Order source
type if you want Oracle Inventory to automatically
generate move orders when you run a replenishment
planning method, such as Min-Max planning.
• True
• False
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You must specify a Pick Wave Move Order source
type if you want Oracle Inventory to automatically
generate move orders when you run a replenishment
planning method, such as Min-Max planning.
• True
• False

False:  You must specify a Replenishment Move
Orders source type if you want Oracle Inventory to
automatically generate move orders when you run a
replenishment planning method.

You must specify a Pick Wave Move Order source
type if you want Oracle Inventory to automatically
generate move orders when you run a replenishment
planning method, such as Min-Max planning.
• True
• False

False:  You must specify a Replenishment Move
Orders source type if you want Oracle Inventory to
automatically generate move orders when you run a
replenishment planning method.
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QuantityQuantityQuantity

TimeTimeTime

121212

666

On-hand qty = 0
New supply = 12
Demand = 12

On-hand qty = 0On-hand qty = 0
New supply = 12New supply = 12
Demand = 12Demand = 12

444

222

On-hand qty = 0
New supply = 10
Demand = 13

On-hand qty = 0On-hand qty = 0
New supply = 10New supply = 10
Demand = 13Demand = 13

On-hand qty = 0
New supply =8
Demand = 4

On-hand qty = 0On-hand qty = 0
New supply =8New supply =8
Demand = 4Demand = 4

101010

888

Beginning of
ATP period

Beginning ofBeginning of
ATP periodATP period

End of ATP
Period

End of ATPEnd of ATP
PeriodPeriod

Describing Available to Promise
Available to promise (ATP) represent the quantity available for sale at any
given period. The basic formula for ATP is
ATP quantity = on-hand quantity + supply - demand - shortage
Note: The shortage in the second period is covered in the third period by using
the concept of forward consumption of shortage, which is a concept explained
later in this module.
The following table provides period ATP quantities for the example shown in
the slide:

Periods ���� 1 2 3

Beginning on-hand quantity 0 0 0

New supply 12 10 8

Period demand 12 13 4

Period ATP 0 - 3 1

Oracle Inventory enables you to define different rules that govern what is
considered supply and demand.
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Defining ATP rules includes
the following:
• Computation options
• Time fence options
• Supply sources
• Demand sources

Defining ATP rules includes
the following:
• Computation options
• Time fence options
• Supply sources
• Demand sources

Setting up items and bills
for ATP checks includes the
following:
• Item ATP rule
• Check ATP attribute
• ATP components

attribute
• Bill Component Check

ATP attribute

Setting up items and bills
for ATP checks includes the
following:
• Item ATP rule
• Check ATP attribute
• ATP components

attribute
• Bill Component Check

ATP attribute
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• You can view the earliest available data for a
specific quantity of an item or a group of items
and the available quantity of an item for a specific
date.

• You can view the supply, demand, and ATP item
quantities for the periods that fall between the
current date and the end of the ATP horizon.

• You can view the earliest available data for a
specific quantity of an item or a group of items
and the available quantity of an item for a specific
date.

• You can view the supply, demand, and ATP item
quantities for the periods that fall between the
current date and the end of the ATP horizon.
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Define ATP rules.

Attach ATP rules to each item.

Attach ATP rules to bills of materials in Oracle Bills
of Material.

Select a default ATP rule for your organization.

Use the ATP Information window to perform ATP
queries.

Enter sales orders in Oracle Order Entry and request
automatic ATP checking.

1

2

3

4

5

6

Checking ATP
Note: Oracle Inventory displays the organization-level default ATP rule
whenever you perform ATP queries in your organization.
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1.  Define computation options.
2.  Specify supply time fence.

3.  Specify end of ATP horizon.

4.  Specify demand time fence.
5.  Specify demand sources.

6.  Specify supply sources.

Defining an ATP Rule
Use the following navigation path to access the ATP Rules window:
(N) Setup > Rules > Available to Promise
You can use the following equation to calculate the ATP quantity for each
supply period.
Period ATP = (period supply) – (period demand)
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Backward ConsumptionBackward ConsumptionBackward Consumption

Forward ConsumptionForward ConsumptionForward Consumption

Describing ATP Consumption Options
When you define ATP rules, you must specify computation options.
Computation options govern how to calculate the ATP quantity in each period.
You can use computation options individually or in combination.
Forward Consumption of Shortage
You can calculate ATP information by using a surplus quantity of an item from
future ATP periods to cover an earlier period shortage.  If the period ATP is
negative, then you can go forward through the supply periods, one at a time, and
subtract the shortage from the available quantity.  You can keep going forward
until the shortage disappears or you run out of periods.
Backward Consumption of Shortage
You can calculate ATP information by using the surplus quantity of an item
from prior ATP periods to cover a period shortage. If the period ATP is
negative, you can go backward through the supply periods, one at a time, and
subtract the shortage from the available quantity.  You can keep going backward
until the shortage disappears or you run out of periods.
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(continued)

Defining Computation Options
(continued)

Accumulation optionsAccumulation optionsAccumulation options

Accumulate AvailableAccumulate AvailableAccumulate Available

WindowWindowWindow

Determining ATP using Accumulation Options
You can use the Accumulate Available option to calculate ATP by carrying
over the available quantity of an item from one ATP period to the next.  Note:
This option assumes backward consumption of shortage.
Entering an Accumulation Window
You can also enter the number of workdays by which to limit the accumulation
of available supply.  The Accumulation Window is measured in workdays based
on the organization calendar and exception set.
The Accumulation Window option prevents the commitment of near-term
supply to orders that have requirement dates far into the future. The
Accumulation Window applies to only the following two computation options:

• Accumulate Available
• Backward Consumption
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Specifying Supply and Demand Time
Fences

Specifying Supply and Demand Time
Fences

A time fence is the total lead time required to
purchase or manufacture an item.  You can define
item time fence options to provide timing information
for the ATP calculation.

The ATP calculation algorithm uses the following
time fences:
• Past-due-supply time fence
• Past-due-demand time fence
• Infinite-supply time fence

A time fence is the total lead time required to
purchase or manufacture an item.  You can define
item time fence options to provide timing information
for the ATP calculation.

The ATP calculation algorithm uses the following
time fences:
• Past-due-supply time fence
• Past-due-demand time fence
• Infinite-supply time fence

Entering Past Due Supply and Demand Days
Past-Due-Supply Days
The ATP process does not consider any supply scheduled before the past-due-
supply time fence date.  The ATP process considers all supply from the
beginning of the past-due-supply time fence date to the current date as supply
for the current date.
Past-due-supply time fence date = (current date) – (past-due-supply days)
Past-Due-Demand Days
The ATP process does not consider any demand scheduled before the past-due-
demand time fence date.  The ATP process considers all demand from the
beginning of the past-due-demand time fence date to the current date as demand
for the current date.
Past-due-demand time fence = (current date) – (past-due-demand days)
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Specifying Supply and Demand Time
Fences (continued)

Specifying Supply and Demand Time
Fences (continued)

Infinite-Supply Option Infinite-Supply Option Infinite-Supply Option 

End of ATP horizonEnd of ATP horizonEnd of ATP horizon
Options

•Cumulative manufacturing lead time
•Cumulative total lead time

•Total lead time

•User-defined time fence

OptionsOptions

••Cumulative manufacturing lead timeCumulative manufacturing lead time
••Cumulative total lead timeCumulative total lead time

••Total lead timeTotal lead time

••User-defined time fenceUser-defined time fence

Selecting an Infinite-Supply Option
The infinite-supply time fence date is the end of the ATP horizon.  Oracle
Inventory does not consider supply sources scheduled on or after this date in
ATP calculations.  The infinite-supply option represents the total time beyond
which the ATP process assumes that infinite supply is available to cover any
scheduled demand.
You can select one of the following infinite-supply options:

• Cumulative manufacturing lead time:  The manufacturing lead time of an
assembly plus the largest adjusted cumulative manufacturing lead time of
its components

• Cumulative total lead time:  The total lead time of an assembly plus the
largest adjusted cumulative total lead time of its components

• Total lead time:  The sum of the preprocessing, processing, and
postprocessing lead times of an item

• User-define time fence:  A lead time that you specify for the item
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Specifying Supply and Demand Time
Fences (continued)

Specifying Supply and Demand Time
Fences (continued)

Supply PeriodSupply PeriodSupply Period

Scheduled
supply date
ScheduledScheduled
supply datesupply date

Next
scheduled

supply
date

NextNext
scheduledscheduled

supplysupply
datedate

Day before
the next

scheduled
supply date

Day beforeDay before
the nextthe next

scheduledscheduled
supply datesupply date

Specifying a Supply Period
Oracle Inventory designates a period as beginning on a scheduled supply date
and ending on the day before the next scheduled supply date.  A supply period
can cover several days or be a minimum of one day.
If supply occurs on a nonworkday, the ATP calculation considers that supply as
belonging to the next workday.  If multiple supply events occur on the same
day, the ATP process considers the total supply.
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Specifying Demand SourcesSpecifying Demand Sources

You can define demand sources for each ATP rule.
Oracle Inventory includes in the ATP calculation only
those demand sources that you enable.

In addition to Oracle’s predefined sources, you can
use your own demand source. To use your own
demand sources, you must populate the user-defined
demand interface table with your external demand
information.

You can define demand sources for each ATP rule.
Oracle Inventory includes in the ATP calculation only
those demand sources that you enable.

In addition to Oracle’s predefined sources, you can
use your own demand source. To use your own
demand sources, you must populate the user-defined
demand interface table with your external demand
information.

Describing ATP Demand
ATP demand is the sum of all demand quantities in the supply period.  If
demand occurs on a nonworkday, the ATP calculation considers that demand as
belonging to the previous workday.
ATP by Demand Class Checkbox
If you select the ATP by Demand Class check box, the ATP calculation
considers only supply and demand for a particular demand class.  The demand
class feature enables you to forecast, plan, and promise based on subdivisions of
your demand. For example, a demand class might represent a large customer or
a group of related customers.
If you select ATP by Demand Class, Oracle Inventory considers only the
following sources of supply:

• Discrete MPS
• Repetitive MPS
• Discrete WIP
• Repetitive WIP
• Nonstandard WIP
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Specifying Supply SourcesSpecifying Supply Sources

You can define supply sources for each ATP rule.
Oracle Inventory includes in the ATP calculation only
for those supply sources that you enable.

You can define supply sources for each ATP rule.
Oracle Inventory includes in the ATP calculation only
for those supply sources that you enable.

Using the Available On-Hand Quantity as the Supply Source
You can decide whether to include available on-hand quantity as a source of
supply.  However, you should not typically use available on-hand quantity as
supply in make-to-order and assemble-to-order environments.
Including User-Defined Supply as a Supply Source
In addition to Oracle’s predefined supply sources, you can use your own supply
source. However, you must populate the user-defined supply interface table
with your external supply information.
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Setting Up Item and Bills for ATP
Checking

Setting Up Item and Bills for ATP
Checking

Update ATP checking ability at the
bill-component level.

Is Item a
component of
an ATO/PTO
assembly?

Assign ATP rule to the item.

Enable components for ATP
checking.

Enable the item for ATP checking.

Is item,
ATP/PTO only, a

parent of an
assembly?

NoNoNo

YesYesYes YesYesYes
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ATP CheckingATP Checking

You set up ATP checking in the Master Item
window, Order Management tab.

Use the following navigation path to access the
Master Items window.

(N) Items > Master Items > (T) Order Management

You set up ATP checking in the Master Item
window, Order Management tab.

Use the following navigation path to access the
Master Items window.

(N) Items > Master Items > (T) Order Management

Enabling ATP Checking When Placing a Demand
If you enable the Check ATP attribute, the item must pass an ATP test before
you can place a demand for it in Oracle Order Management. When you place a
demand for the item in Oracle Order Management, the ATP process checks to
see if there is sufficient quantity.
If you decide not to enable the Check ATP attribute, then you can place a
demand for the item even if there is not sufficient stock to satisfy the demand.
You should not enable the Check ATP attribute for items that are noncritical,
rarely out of stock, on a short manufacturing cycle, or replenishable on short
notice.
Specifying an Item ATP Rule
Oracle Inventory uses the ATP rule that you assigned to check ATP when you
place a demand for the item in Oracle Order Management.  If you do not specify
an ATP rule for the item, the ATP process uses the organization-level default
ATP rule that you enter in the Organization Parameters window.
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ATP Checking (continued)ATP Checking (continued)

You can select the ATP Components attribute of
Oracle Inventory only if you select one of the
following attribute values for the item:
• Assemble to Order
• Pick Components
• A phantom WIP Supply Type

You can select the ATP Components attribute of
Oracle Inventory only if you select one of the
following attribute values for the item:
• Assemble to Order
• Pick Components
• A phantom WIP Supply Type

Selecting the ATP Components Attribute
If you enable the ATP Components attribute for an assembly, you can place a
demand for the assembly only if all of the components with the enabled Check
ATP attribute at the bill-component level pass the ATP check.  If you enable the
Check ATP attribute for the assembly, then the assembly must also pass the
ATP check before you can place a demand for it.
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ATP Checking (continued)ATP Checking (continued)

Oracle Inventory:  ATP
Components attribute

Oracle Inventory:  ATPOracle Inventory:  ATP
Components attributeComponents attribute

Oracle Bills of Material:
Check ATP attribute

Oracle Bills of Material:Oracle Bills of Material:
Check ATP attributeCheck ATP attribute

Setting the Check ATP attribute at the Bill Level
Use the following navigation path to access the Bill of Material window:
Navigate to the Oracle Bills of Material application, (N) Bills > Bills.
If an item is a component in a bill of material, you can change the value of the
Check ATP attribute, at the bill-component level, to something other than what
you set at the master-item level.
If you enabled the Check ATP attribute when you defined the item, you can
decide whether to enable or disable the component Check ATP attribute.
If you decide not to enable the Check ATP attribute when you defined the item,
Oracle Inventory does not enable the bill component Check ATP attribute.
This enables you to set up items that require passing ATP checks when ordered
directly, but that do not require passing ATP checks when they are components
of an assembly.
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Oracle Inventory calculates ATP quantities based on
the ATP rule that you select in the ATP Criteria
window. Use the following navigation path to access
the ATP Criteria window:

(N) On-hand, Availability > Available to Promise

Oracle Inventory calculates ATP quantities based on
the ATP rule that you select in the ATP Criteria
window. Use the following navigation path to access
the ATP Criteria window:

(N) On-hand, Availability > Available to Promise

Viewing ATP Information for Individual Items
When you set up ATP criteria, you must specify the following information:

• Required quantity
• Required date

Oracle Inventory then displays the following ATP results:
• Earliest date on which the required quantity will be available
• ATP quantity for the required date

Viewing ATP Information for a Group of Items
Oracle Inventory returns the date when all for the items in the group will be
available.  You can view the ATP result and supply and demand detail for each
item by navigating to the ATP by Period and Supply/Demand Detail windows,
respectively.
Viewing ATP Information for a Demand Class
You can view ATP information for individual items and groups of items that
belong to a particular demand class.



Copyright © Oracle Corporation, 2000. All rights reserved.

Oracle Inventory Replenishment II, Release 11i
Chapter 1 - Page 89

Practice 4 Overview: Setting Up ATP Rules and
Performing ATP Checking

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Practice 4 Overview: Setting Up ATP
Rules and Performing ATP Checking
Practice 4 Overview: Setting Up ATP
Rules and Performing ATP Checking

Purpose: In this practice, you will define and ATP rule
and perform ATP checking for an item.
Purpose: In this practice, you will define and ATP rule
and perform ATP checking for an item.

Practice 4: Setting Up ATP Rules and Performing ATP Checking
Instructions

Note: Wherever you see XX, substitute your student number.
1. Define an ATP rule.

(N) Setup > Rules > Available to Promise
• Name XX-ATP Rule
• Description Your ATP rule
• Accumulate AvailableLeave blank (no)
• Past due demand days 50
• Past due supply days 50
• Infinite supply option User defined time fence
• Infinite supply days 15
• ATP by demand class No
• Leave all other options as is
• Save your work. (M) File > Save
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Practice 4: Setting Up ATP Rules and
Performing ATP Checking

Practice 4: Setting Up ATP Rules and
Performing ATP Checking

Practice 4: Setting Up ATP Rules and Performing ATP Checking
2.  Apply your ATP rule to one of your items that has existing stock.

(N) Items > Master Items
• Enter your stocked item in the Find window and then click the Find
button.
• In the ATP Rule field, select your ATP rule from the list of values.

3.  Check the ATP using your rule.
(N) On-Hand Availability > Available to Promise
• Default ATP rule Your ATP rule
• Click the ATP Criteria button

– Double click the item field Select your item from Step 2
– Quantity 1000
– Required Day 1 week from today

• Click the ATP Results button to view your results
4.  Can you promise 1000 of these items on the date that you entered?____
5.  How many can you promise on that date?__________
6.  When can you promise the rest?______
Page down to review ATP information by period and by supply and demand.
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 Agenda Agenda

• Module Overview
• Performing Reorder-point Planning
• Performing Min-max Planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move-orders
• Setting up available to promise (ATP)
• Setting up Inventory profile values

• Module Overview
• Performing Reorder-point Planning
• Performing Min-max Planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move-orders
• Setting up available to promise (ATP)
• Setting up Inventory profile values
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Inventory Profile ValuesInventory Profile Values

Profile values specify how Oracle Inventory
processes and controls access to data. Profile
values can typically be set at one or more of the
following levels:
• Site
• Application
• Responsibility
• User

Profile values specify how Oracle Inventory
processes and controls access to data. Profile
values can typically be set at one or more of the
following levels:
• Site
• Application
• Responsibility
• User
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Inventory Profile Values (continued)Inventory Profile Values (continued)

• You use the Personal Profile Values window to set
profile values at the user level.

• System administrators use the System Profile
Values window to set profile values at the site,
application, responsibility, and user levels.

• Use the following navigation path to access the
System Profile Values window:
(N) Setup > Profiles > System

• You use the Personal Profile Values window to set
profile values at the user level.

• System administrators use the System Profile
Values window to set profile values at the site,
application, responsibility, and user levels.

• Use the following navigation path to access the
System Profile Values window:
(N) Setup > Profiles > System

Setting Up System Profile Values
Use the Find feature in the System Profile Value window to locate the following
system profile values that you should set up for Oracle Inventory planning:

• Min-max Reorder Approval
• RC Line Failure
• RC Requisition Approval
• Enter Replenishment Count form

Setting Up Personal Profile Values
Use the following navigation path to access the personal profile values that you
should set up for Oracle Inventory planning:
(N) Setup > Profiles > Personal

• Min-max Reorder Approval
• RC Line Feature
• RC Requisition Approval
• Enter Replenishment Count form
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SummarySummary

This module explained the following topics:
• Performing Reorder-point planning
• Performing Min-max planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move orders
• Setting up available to promise (ATP)
• Performing ATP checks
• Setting up inventory planning profile options

This module explained the following topics:
• Performing Reorder-point planning
• Performing Min-max planning
• Performing replenishment counting
• Generating kanban cards
• Describing replenishment move orders
• Setting up available to promise (ATP)
• Performing ATP checks
• Setting up inventory planning profile options
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